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Notice

1. Descriptions of circuits, software and other related information in this document are provided only to illustrate the
operation of semiconductor products and application examples. You are fully responsible for the incorporation of these
circuits, software, and information in the design of your equipment. Renesas Electronics assumes no responsibility for
any losses incurred by you or third parties arising from the use of these circuits, software, or information.

2. Renesas Electronics has used reasonable care in preparing the information included in this document, but Renesas
Electronics does not warrant that such information is error free. Renesas Electronics assumes no liability whatsoever
for any damages incurred by you resulting from errors in or omissions from the information included herein.

3. Renesas Electronics does not assume any liability for infringement of patents, copyrights, or other intellectual property
rights of third parties by or arising from the use of Renesas Electronics products or technical information described in
this document. No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other
intellectual property rights of Renesas Electronics or others.

4. You should not alter, modify, copy, or otherwise misappropriate any Renesas Electronics product, whether in whole or
in part. Renesas Electronics assumes no responsibility for any losses incurred by you or third parties arising from such
alteration, modification, copy or otherwise misappropriation of Renesas Electronics product.

5. Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High
Quality”. The recommended applications for each Renesas Electronics product depends on the product’s quality grade,
as indicated below.

“Standard”: Computers; office equipment; communications equipment; test and measurement equipment; audio
and visual equipment; home electronic appliances; machine tools; personal electronic equipment; and industrial
robots etc.

“High Quality”: Transportation equipment (automobiles, trains, ships, etc.); traffic control systems; anti-disaster
systems; anticrime systems; and safety equipment etc.

Renesas Electronics products are neither intended nor authorized for use in products or systems that may pose a
direct threat to human life or bodily injury (artificial life support devices or systems, surgical implantations etc.), or may
cause serious property damages (nuclear reactor control systems, military equipment etc.). You must check the quality
grade of each Renesas Electronics product before using it in a particular application. You may not use any Renesas
Electronics product for any application for which it is not intended. Renesas Electronics shall not be in any way liable
for any damages or losses incurred by you or third parties arising from the use of any Renesas Electronics product for
which the product is not intended by Renesas Electronics.

6. You should use the Renesas Electronics products described in this document within the range specified by Renesas
Electronics, especially with respect to the maximum rating, operating supply voltage range, movement power voltage
range, heat radiation characteristics, installation and other product characteristics. Renesas Electronics shall have no
liability for malfunctions or damages arising out of the use of Renesas Electronics products beyond such specified
ranges.

7. Although Renesas Electronics endeavors to improve the quality and reliability of its products, semiconductor products
have specific characteristics such as the occurrence of failure at a certain rate and malfunctions under certain use
conditions. Further, Renesas Electronics products are not subject to radiation resistance design. Please be sure to
implement safety measures to guard them against the possibility of physical injury, and injury or damage caused by fire
in the event of the failure of a Renesas Electronics product, such as safety design for hardware and software including
but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for aging degradation or
any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult, please
evaluate the safety of the final products or systems manufactured by you.

8. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental
compatibility of each Renesas Electronics product. Please use Renesas Electronics products in compliance with all
applicable laws and regulations that regulate the inclusion or use of controlled substances, including without limitation,
the EU RoHS Directive. Renesas Electronics assumes no liability for damages or losses occurring as a result of your
noncompliance with applicable laws and regulations.

9. Renesas Electronics products and technology may not be used for or incorporated into any products or systems whose
manufacture, use, or sale is prohibited under any applicable domestic or foreign laws or regulations. You should not
use Renesas Electronics products or technology described in this document for any purpose relating to military
applications or use by the military, including but not limited to the development of weapons of mass destruction. When
exporting the Renesas Electronics products or technology described in this document, you should comply with the
applicable export control laws and regulations and follow the procedures required by such laws and regulations.

10. Itis the responsibility of the buyer or distributor of Renesas Electronics products, who distributes, disposes of, or
otherwise places the product with a third party, to notify such third party in advance of the contents and conditions set
forth in this document, Renesas Electronics assumes no responsibility for any losses incurred by you or third parties as
a result of unauthorized use of Renesas Electronics products.

11. This document may not be reproduced or duplicated in any form, in whole or in part, without prior written consent of
Renesas Electronics.

12. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this
document or Renesas Electronics products, or if you have any other inquiries.

(Note 1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its
majority owned subsidiaries.

(Note 2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.

(2012.4)




Disclaimer

By using this Renesas Starter Kit (RSK), the user accepts the following terms:

The RSK is not guaranteed to be error free, and the entire risk as to the results and performance of the RSK is
assumed by the User. The RSK is provided by Renesas on an “as is” basis without warranty of any kind whether
express or implied, including but not limited to the implied warranties of satisfactory quality, fitness for a particular
purpose, title and non-infringement of intellectual property rights with regard to the RSK. Renesas expressly
disclaims all such warranties. Renesas or its affiliates shall in no event be liable for any loss of profit, loss of data,
loss of contract, loss of business, damage to reputation or goodwill, any economic loss, any reprogramming or recall
costs (whether the foregoing losses are direct or indirect) nor shall Renesas or its affiliates be liable for any other
direct or indirect special, incidental or consequential damages arising out of or in relation to the use of this RSK, even
if Renesas or its affiliates have been advised of the possibility of such damages.

Precautions

The following precautions should be observed when operating any RSK product:

This Renesas Starter Kit is only intended for use in a laboratory environment under ambient temperature and humidity
conditions. A safe separation distance should be used between this and any sensitive equipment. Its use outside the
laboratory, classroom, study area or similar such area invalidates conformity with the protection requirements of the
Electromagnetic Compatibility Directive and could lead to prosecution.

The product generates, uses, and can radiate radio frequency energy and may cause harmful interference to radio
communications. However, there is no guarantee that interference will not occur in a particular installation. If this
equipment causes harmful interference to radio or television reception, which can be determined by turning the
equipment off or on, you are encouraged to try to correct the interference by one or more of the following measures;

e ensure attached cables do not lie across the equipment

e reorient the receiving antenna

e increase the distance between the equipment and the receiver

e connect the equipment into an outlet on a circuit different from that which the receiver is connected
e power down the equipment when not in use

e consult the dealer or an experienced radio/TV technician for help NOTE: It is recommended that wherever
possible shielded interface cables are used.

The product is potentially susceptible to certain EMC phenomena. To mitigate against them it is recommended that the
following measures be undertaken;

e The user is advised that mobile phones should not be used within 20m of the product when in use.
e The user is advised to take ESD precautions when handling the equipment.

The Renesas Starter Kit does not represent an ideal reference design for an end product and does not fulfil the
regulatory standards for an end product.




How to Use This Manual

1. Purpose and Target Readers

This manual is designed to provide the user with an understanding of how to use Application Leading Tool
(Code Generator) for RX together with the CS+ IDE to create a working project for the RSK platform. It is
intended for users designing sample code on the RSK platform, using the many different incorporated
peripheral devices.

The manual comprises of step-by-step instructions to generate code and import it into CS+, but does not
intend to be a complete guide to software development on the RSK platform. Further details regarding
operating the RX24T microcontroller may be found in the Hardware Manual and within the provided sample
code.

Particular attention should be paid to the precautionary notes when using the manual. These notes occur within the body
of the text, at the end of each section, and in the Usage Notes section.

The revision history summarizes the locations of revisions and additions. It does not list all revisions. Refer to the text of
the manual for details.

The following documents apply to the RX24T Group. Make sure to refer to the latest versions of these
documents. The newest versions of the documents listed may be obtained from the Renesas Electronics Web
site.

Document Description Document Title Document No.
Type

User’s Manual Describes the technical details of the RSKRX24T User’s Manual R20UT3436EG
RSK hardware.

Tutorial Manual Provides a guide to setting up RSK RSKRX24T Tutorial Manual R20UT3437EG
environment, running sample code and
debugging programs.

Quick Start Provides simple instructions to setup the RSKRX24T Quick Start Guide R20UT3438EG

Guide RSK and run the first sample.

Code Generator Provides a guide to code generation RSKRX24T Code Generator R20UT3439EG

Tutorial Manual and importing into the CS+ IDE. Tutorial Manual

Schematics Full detail circuit schematics of the RSK. RSKRX24T Schematics R20UT3435EG

Hardware Provides technical details of the RX24T RX24T Group Hardware RO1UHO576EJ

Manual microcontroller. Manual




2. List of Abbreviations and Acronyms

Abbreviation

Full Form

ADC Analog-to-Digital Converter

API Application Programming Interface

bps Bits per second

CMT Compare Match Timer

COM COMmunications port referring to PC serial port

CPU Central Processing Unit

DVD Digital Versatile Disc

El Renesas On-chip Debugging Emulator

GUI Graphical User Interface

IDE Integrated Development Environment

IRQ Interrupt Request

LCD Liquid Crystal Display

LED Light Emitting Diode

LSB Least Significant Bit

LVD Low Voltage Detect

MCU Micro-controller Unit

MSB Most Significant Bit

PC Personal Computer

Pmod™ This is a Digilent Pmod™ Compatible connector. Pmod™ is registered to Digilent Inc.
Digilent-Pmod_Interface_Specification

PLL Phase-locked Loop

RAM Random Access Memory

ROM Read Only Memory

RSK Renesas Starter Kit

RTC Realtime Clock

SAU Serial Array Unit

SCI Serial Communications Interface

SPI Serial Peripheral Interface

TAU Timer Array Unit

TFT Thin Film Transistor

TPU Timer Pulse Unit

UART Universal Asynchronous Receiver/Transmitter

USB Universal Serial Bus

WDT Watchdog timer

All trademarks and registered trademarks are the property of their respective owners.



http://www.digilentinc.com/index.cfm
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ENESANS

RSKRX24T
RENESAS STARTER KIT

R20UT3439EG0100
Rev. 1.00
Dec 29, 2015

1. Overview

1.1  Purpose

This RSK is an evaluation tool for Renesas microcontrollers. This manual describes how to use the CS+ IDE

code generator plug in to create a working project for the RSK platform.

1.2 Features

This RSK provides an evaluation of the following features:
« Project Creation with CS+

« Code Generation using the code generator plug in.
« User circuitry such as switches, LEDs and a potentiometer

The RSK board contains all the circuitry required for microcontroller operation.

R20UT3439EG0100 Rev. 1.00
Dec 29, 2015 RENESAS
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RSKRX24T 2. Introduction

2. Introduction

This manual is designed to answer, in tutorial form, how to use the code generator plug in for the RX family
together with the CS+ IDE to create a working project for the RSK platform. The tutorials help explain the
following:

e Project generation using the CS+

e Detailed use of the code generator plug in for CS+
e Integration with custom code

e Building the project CS+

The project generator will create a tutorial project with three selectable build configurations:
o ‘DefaultBuild’ is a project with debug support and optimisation level set to two.
o ‘Debug’ is a project built with the debugger support included. Optimisation is set to zero.

o ‘Release’ is a project with optimised compile options (level two) and no outputs debugging information
options selected, producing code suitable for release in a product.

The tutorial examples in this manual assume that installation procedures described in the RSK Quick Start
Guide have been completed. Please refer to the Quick Start Guide for details of preparing the configuration.

These tutorials are designed to show you how to use the RSK and are not intended as a comprehensive introduction to
the CS+ debugger, compiler toolchains or the E1 emulator. Please refer to the relevant user manuals for more in-depth
information.

R20UT3439EG0100 Rev. 1.00 ————
Dec 29, 2015 RENESAS




RSKRX24T 3. Project Creation with CS+

3. Project Creation with CS+

3.1 Introduction
In this section the user will be guided through the steps required to create a new C project for the RX24T MCU,

ready to generate peripheral driver code using Code Generator. This project generation step is necessary to
create the MCU-specific project and debug files.

3.2 Creating the Project
To use the program, start CS+:

Windows™ 7 & Vista: Start Menu > All Programs > Renesas Electronics CS+ > CS+ for CC
(RL78,RX,RH850)

Windows™ 8.1 & 8: From Apps View @ click ‘CS+ for CC (RL78,RX,RH850)’ icon

e CS+ will show the Start Page. Use the Create New Project
‘GO’ button to Create a New Project. Anew project can be created.

A new project can also be created by reusing the file configuration registered to an existing project.

Crreate New Multi-rore Proient

e In the ‘Create Project’ dialog, select | | CreateProject ==
‘RX’ from the ‘Microcontroller’ pull-
down Microcantroller: RX |Z|
e In the ‘Using Microcontroller’ list || Usingmicrocontroller
control, scroll down to ‘RX24T’ and || & Sesrchmicrocontroller)
expand the tree control by clicking *+'. & Wy RO23T ~ | [ Product Name REF524T AP "
¢ n)’ ey On-chip ROM size[KBytes]: 256
Select ‘R5F524TAAXFP(100pin)’. = 'm§;F524T&%FF[EDpin] o<t M et eoes
° Ensure that in the ‘Kind of project’ pU”- RSF524T8AxFN(20pin) =|| | Addtional Information:Package=PLQP0100KE-A
down, ‘Empty Application(CC-RX)" is REFS24T8AxFP(100pin)
lected REF524T Al FF{20pin)
selected. W RSF524TALFN(20pin)
e Choose an appropriate name and W-;-‘_EE M -
location for the project, then click
‘Create’ Kind of project: Empty Application(CC-RX) |Z|
Note: this tutorial assumes the project || Proisctname: CG_Tutorial
is named and located at the place Place: Coworkspace E

shown opposite.

Make the project folder
e If the folder entered cannot be found a

‘Question’ dialogue WI” be dlsplayed, C:wiorkspace'CG_Tutorial\CG_Tutorial mtp)
CIiCk 'Yes'. [T Pass the file composition of an existing project to the new project
Project to be passed: Browse...
Copy composition files in the diverted project folder to a new project folder.
Create l ’ Cancel ] [ Help

Dec 29, 2015




RSKRX24T 3. Project Creation with CS+

e CS+ will create the blank project with | [ZEEEREES o x
the standard project tree. A ‘Code 5 @ 8@
Generator’ node may also be shown, if :

n;ﬂ Code Generator Property

previously enabled. E!---I:E CG Tutorial (Project 4 Generate File Mode
; # RSF524TAAXFP (Microcontroller) AP output contral

Code Generator (Design Tool) Coding format contral

: 4\ CC-RX (Build Tool) Qutput folder
..... 25! R¥ Simulator (Debug Tool) File generation control
i ﬂ, File Register files

Report type

4 Product Information

R20UT3439EG0100 Rev. 1.00 = ZENES NS Page 10 of 50
Dec 29, 2015



RSKRX24T 4. Code Generation Using the CS+ plug in

4. Code Generation Using the CS+ plug in

4.1 Introduction

Code Generator is a Windows™ GUI tool for generating template ‘C’ source code and project settings for the
RX24T. When using Code Generator, the user is able to configure various MCU features and operating
parameters using intuitive GUI controls, thereby bypassing the need in most cases to refer to sections of the
Hardware Manual.

By following the steps detailed in this tutorial, the user will generate a CS+ project called CG_Tutorial. A fully
completed Tutorial project is contained on the DVD and may be imported into CS+ by following the steps in
the Quick Start Guide. This tutorial is intended as a learning exercise for users who wish to use the Code
Generator to generate their own custom projects for CS+.

Once the user has configured the project, the ‘Generate Code’ function is used to generate three code
modules for each specific MCU feature selected. These code modules are name ‘r_cg_xxx.h’, ‘r_cg_xxx.c’,
and ‘r_cg_xxx_user.c’, where ‘xxx’ is a three letter acronym for the relevant MCU feature, for example ‘adc’.
Within these code modules, the user is then free to add custom code to meet their specific requirement.
Custom code should be added, whenever possible, in between the following comment delimiters:

/* Start user code for adding. Do not edit comment generated here */
/* End user code. Do not edit comment generated here */

Code Generator will locate these comment delimiters, and preserve any custom code inside the delimiters on
subsequent code generation operations. This is useful if, after adding custom code, the user needs to re-visit
Code Generator to change any MCU operating parameters.

The CG_Tutorial project uses interrupts for switch inputs, the ADC module, the Compare Match Timer (CMT),
the Serial Communications Interface (SCI) and uses these modules to perform A/D conversion and display the
results via the Virtual COM port to a terminal program and also on the LCD display on the RSK.

Following a tour of the key user interface features of Code Generator in 84.3, the reader is guided through
each of the peripheral function configuration dialogs in 84.4. In 85, the reader is familiarised with the structure
of the template code, as well as how to add their own code to the user code areas provided by the code
generator.

4.2 Enabling Code Generator

After installation of CS+, Code Generator must be enabled. This step is only required once, CS+ will
remember this setting on subsequent launches.

From the ‘Tool' pull-down menu select ‘Plug-in Setting...”. On the ‘Additional Function’ tab, click the box next to
the ‘Code Generator/Pin View Plug-in’ option and ensure it is ticked:

Basic Function

Module Name Description
[ ;_{( Code Generator Plug4n Plug+in to generate the device driver automatically for VB50, 78KD, 7BKDR, RL78/G12 G13. G1

CodeGawﬁoran\ﬁav Plug-in Plugn to generate the device driver automatically and to view the device corfiguration. for R,

Click ‘OK’. CS+ needs to restart to enable this selection, select ‘Yes’ from the Question dialogue box.
After restarting, ‘Code Generator (Design Tool)' node will now be shown in the left-hand ‘Project Tree’ window
pane.

Project Tree 3 x

2 @ 8| &

: O 3 D:~I Code Generator Property
=175 £G Tutorial (Project 2 Generate File Mod

JE RSF524TAAFP (Microcontroller) AP output control

| Code Generator (Design Tool) Coding format control

Ay, CC-RX (Build Tool) Cutput folder

5, RX Simulator (Debug Tool) File generation contrel
j_], File Register files
Report type

4 Product Information

R20UT3439EG0100 Rev. 1.00 RENESAS Page 11 of 50
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RSKRX24T 4. Code Generation Using the CS+ plug in

4.3 Code Generator Tour

This section presents a brief tour of Code Generator. For further details of the Code Generator paradigm and
reference, refer to the Application Leading Tool Common Operations manual.

You can download the latest document from: http://www.renesas.com/applilet

Application Leading Tool is the stand-alone version of Code Generator and this manual is applicable to the
Code Generator.

In the Project Tree pane, click on the icon next to ‘Code Generator’ node to expand the list.

Expand the ‘Peripheral Functions’ node by clicking on the next to it.

Open the ‘Peripheral Function’ tab by double clicking on the ‘Peripheral Functions’ name.

The CS+ main window will now contain a ‘Peripheral Functions’ tab with the Initial View as show in Figure 4-1.

CG_Tutorial - C5+ for CC - [Peripheral Functions] E@
File Edit View Project Build Debug Tool Window Help
&R ostart | (B B @l X Ha @0 O |5 A A - B B DefaultBuild » A G Dy ® (B ") @ 5= 0= %= | 2%
BEEEREFERNACER0E 08395
Project Tree "X Property f,‘| Peripheral Functions =l
A —
: @ 38E - o o a dE % < = n 2 .
e 5] GenerstzCode | % (3 S e @ ML SR D G D D BT E S G
=3 CG Tutorial (Project =I5 ey "
RSF524TAAFP (Micracentroller) i Clock sefiing}| Block disgram |
Code Generator (Design Tool) Main cleck oscillator setting
/" Pin View Operation
o-E Peripheral Functions Main clock oscillation source Resonator -
r; L
- " Voltage Detection Circuit Frequency 8 (MHz) i
-8 Clock Frequency Accuracy b Oscilator wat time 2192 cycles - 2048 (=)
- Low Power Consumption
. Interrupt Controller Unit Oscillation stop detection function Disabled -
- b
Buses PLL circuit setting
- W’ Data Transfer Controller .
W 10 Ports i
- ®" Multi-Function Timer Pulse | x1
-’ Port Qutput Enable 3 3 o
x8
& §-Bit Timer
w' Compare Match Timer 64
&' Independent Watchdog Tim| .
%' Serial Communications Intel Low speed clock oscillator (LOCO) setting
¥ 1C BusInterface By i
W' Serial Peripheral Interface Eomononoe 4 Ao
W CRC Calculator Sl > £
-7 12-Bit A/D Converter EOF] -
- DfA Converter
- Comparater C
- Data Operation Circuit =
ol Code Preview =
- %, CC-RX (Build Tool) N y -
550 RX Simulator (Debug Tool) . ||\ All Messages / M
4 [ . » & Output EI: Error List‘
F? Open Helpf. |2 Rename F3 Find Next F Replace Next HF.'} Go F& Build & Dow.. ||[F7 Build Project |[F8 lgnore Break .. HFH SetiDelete B M Step Over FflStep In FI2 Jump to Fun..
512 DISCONNECT

Figure 4-1 Initial View

Code Generator provides GUI features for configuration of MCU subsystems and peripherals. Once the user
has configured all required MCU subsystems and peripherals, the user can click the ‘Generate Code’ button,
resulting in a fully configured CS+ project.

Navigation to the MCU peripheral configuration screens may be performed by double-clicking the required
function in the Project Tree -> Project Name -> Peripheral Function on the left.

It is also possible to see a preview of the code that will be generated for the current peripheral function
settings by double-clicking the required function in the Project Tree -> Project Name -> Code Preview on the
left.

R20UT3439EG0100 Rev. 1.00
Dec 29, 2015

RENESAS Page 12 of 50
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RSKRX24T 4. Code Generation Using the CS+ plug in

4.4 Code Generation

In the following sub-sections, the reader is guided through the steps to configure the MCU for a simple project
containing interrupts for switch inputs, timers, ADC and a UART.

44.1 Clock Generator

Figure 4-2 shows a screenshot of Code Generator with the Clock Generator function open. Click on the
‘Clock setting’ sub tab. Configure the system clocks as shown in the figure. In this tutorial we are using the
on board 20 MHz crystal resonator for our main clock oscillation source and the PLL circuit is in operation.
The PLL output is used as the main system clock and the divisors should be set as shown in Figure 4-2.

ﬁ,_‘l Peripheral Functions™

%] GenerateCode | % [ o [ @ M 5 53 D 0% O D & F o 7 G &2
Mﬂ.l Block diagram |

" Property

Main clock oscillator setting

Operation

Main clock oscillation source Resonator -
Frequency 20 (MHz)
Oscillator wait time 8152 cycles - 2048 (us)
Oscillation stop detection function Disabled -

PLL circuit setting

Operation

Input frequency division ratio x 12 -
Frequency multiplication factor x8 -
Frequency 80 (MHz)

Low speed clock oscillator (LOCO) setting
[ Operation

System clock setting

Clock source PLL circuit -
System clock (ICLK) x1 - 80 {MHz)
Peripheral module clock {(PCLKA) x1 - 80 (MHz)
Peripheral module clock (PCLKEB) w12 - A0 (MHz)
Peripheral module clock for ADC (PCLKD) x1/2 - 40 (MHz)
Flash IF clock (FCLK) x 14 - 20 (MHz)
wWDT-dedicated low-speed clock oscillator (IWDTLOCO) setting
[ Operation
15
Figure 4-2 Clock setting tab
Proceed to the next section on Interrupt
R20UT3439EG0100 Rev. 1.00 RENESANAS Page 13 of 50
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RSKRX24T

4. Code Generation Using the CS+ plug in

4.4.2 Interrupt Controller Unit

Referring to the RSK schematic, SW1 is connected to IRQO (P10) and SW2 is connected to IRQ5 (P02).
SW3 is connected directly to the ADTRGOn and will be configured later in 84.4.4. Navigate to the ‘Interrupt
Controller Unit’ node in Code Generator and in the ‘General’ tab, configure these two interrupts as falling edge

triggered as shown in Figure 4-3 below.

Figure 4-3 Interrupt Functions tab

PFBDBI'W|E§ Peripheral Functions™
] GenerateCode | % 0 & 1= & ¥ & 58 D G B D £ .7 8 F & S M=
— Fast interrupt setting
[ Fast intemupt ntemupt source | BSC (BUSERR vect=16)
— Software interrupt setting
[ Software intemupt Priority | Level 15 (highest)
—NMI setting
[] NMI pin irtempt Valid edge | Falling L ter | Mo filter 0 H
—IRQO setting
IR0 Pin P10 - Digital fiter Mo filter 0 H
Valid edge  Falling - Priorty  Level 15 (highest)
—IRQ1 setting
[ IrRal Pin | P11 L ter | Mo filter 0 H
edge | Low level Pr Level 15 (highest)
-IRQ2 setting
[ Ira2 PFin | POD L ter | Mo filter 0 H
edge | Low level Pr Level 15 (highest)
- IRQ3 setting
[ Ira3 Pin | P55 L ter | Mo filter 0 H
edge | Lowlevel Pr Level 15 (highest)
- IRQ4 setting
1] 1IRQ4 PFin | PO1 L ter | Mo filter 0 H
edge | Low level Pr Level 15 (highest)
— IRQ5 setting
IRQ5 Fin P02 - Digital fiter Mo filter 0 H
Vald edge  Falling - Priorty  Level 15 (highest)
- IRQE setting
[ IRG6 Pin | P21 L ter | Mo filter 0 H
edge | Low level Pr Level 15 (highest)
-IRQ7 setting
[ Ira7 PFin | P20 L ter | Mo filter 0 H
edge | Lowlevel Pr Level 15 (highest)
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RSKRX24T 4. Code Generation Using the CS+ plug in

4.4.3 Compare Match Timer

Navigate to the ‘Compare Match Timer’ node in Code Generator. CMTO will be used as an interval timer for
generation of accurate delays. CMT1 and CMT2 will be used as timers in de-bouncing of switch interrupts.

In the ‘CMTO’ sub-tab configure CMTO as shown in Figure 4-4. This timer is configured to generate a High
priority interrupt every 1ms. We will use this interrupt later in the tutorial to provide an API for generating high
accuracy delays required in our application.

1 Property | 55 Peripheral Functions® \—
Bl GenenteCode | L QO BEFBESDODD BT oS EOH MBI
CMTO | cMT1 | cmT2 | cMT3 |

Compare match timer operation setting

) Unused @ Used
Count clock setting
@ PCLK/8 @ PCLK/32 @ PCLK/128 @ PCLK/B12

Interval value sething

Interval value 1 ms » (Actual value: 1)
Interrupt setting

Enable compare match intermupt (CMI0)

Priority Level 10 -

Figure 4-4 CMTO tab

Navigate to the ‘CMT1’ sub-tab and configure CMT1 as shown in Figure 4-5. This timer is configured to
generate a High priority interrupt after 20ms. This timer is used as our short switch de-bounce timer later in
this tutorial.

71 Property j_’,_ﬂ Peripheral Functions™
f] GenerateCode | 5 [0 & [ # ¥ 5 50 @ @ @ @ & J o J I i o M 2
| cMTO | CMT1 | cMT2 | CMT3 |

Compare match timer operation setting
) Unused @ Used

Count clock setting
@) PCLKSB @ PCLK/32 @ PCLKM2B @) PCLK/S12

Interval value setting
Interval value 20 ms w (Actual value: 20)

Interrupt setting
Enable compare match intemupt (CMI1)

Priority Level 10 -

Figure 4-5 CMT1 tab

Navigate to the ‘CMT2’ sub-tab and configure CMT2 as shown in Figure 4-6. This timer is configured to
generate a High priority interrupt after 200ms. This timer is used as our long switch de-bounce timer later in
this tutorial.

R20UT3439EG0100 Rev. 1.00 RENESAS Page 15 of 50
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4. Code Generation Using the CS+ plug in

E,:d Peripheral Functions®

] GenerateCode | % J A X ¥ M &M D R DD L FT 7 E M2
| cmTo | cuT1| CMT2 | cMT3 |

() Unused

- Count clock setting

- Compare match timer operation setting

@ Used

© PCLK/B

— Interval value setting

@ PCLKA32

i©) PCLKA128

@ PCLK/512

4.4.4 12-bit A/D Converter

Figure 4-6 CMT2 tab

Interval value 200 ms »  (Actual value: 200)
- Interrupt setting
Enable compare match intemupt {CMI2)
Priority Level 10 -

Navigate to the '12-bit A/D Converter’ tab in Code Generator. In the ‘S12ADO0’ sub-tab configure S12ADO0 as
shown in Figure 4-7, Figure 4-8 and configure the S12ADO0 as shown. We will be using the S12ADO in 12-bit
one shot mode on the ANOOO input, which is connected to the RV1 potentiometer output on the RSK. The
conversion start trigger will be via the pin connected to SW3.

% Property j,_!! Peripheral Functions™
=

E;J Generate Code | /%

L

DA E#HBEBODOLDD LT ET RO ME

S124D0 | 5124D1 | 512402 |

@ Used

—512AD0 operation setting
) Unused
— Operation mode setting

@ Single scan mode

- Group scan select

() Group scan mode

() Continuous scan mode

@ Two groups (A.B

— Double trigger mode setting

@ Disable

- Self diagnosis setting

Mode

- Disconnection detection assist setting

Charge setting

== ABLC
() Enable
Unused -
Use AVCCOx 0
Unused -

- AD converted value count setting

Group without pricrity
Mot restarted or continued due to Group priority

Restarted from the first scan channel

@ Addtion mode

() Average mode

— Analog input channel setting

Convert Cor Add/Awverage
(Group A} G AD value
ANODO =
ANDD1 ]
ANOD2 =
ANDD3 ]
ANOTE 0

Figure 4-7 A/D Converter tab-1

Programmable gain
amplifier

[l
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4. Code Generation Using the CS+ plug in

- Programmable gain amplifier setting

[] Enable pass-through amplifier ANDDO
Amplifier gain selection

2,000 v

— Conversion start trigger setting
Conversion start tigger (Group A)

AD conversion start trigger pin -
Conversion start trigger (Group B)
| Compare match with or input capture to MTUD. TGRA - |
Conversion start trigger (Group C)
]

| Compare match with or input capture to MTU1.TGRA

- Data

~ANDOD / Self-di

— Output setting

ADTRGO# pin selection PA4 -
g setting

AD converted value addition count 1-time conversion -

Data placement Right-alignment -

Automatic clearing Disable automatic clearing -

time setting

Input sampling time 3667 (s} (Actual value: 3.675)
- ANDDT conversion time setting

Input sampling time |3.EE? | (b=} (Actual value: 3.675)
- ANDD2 conversion time setting

Input sampling time |3.EE? | (b=} (Actual value: 3.675)
- ANDD2 conversion time setting

Input sampling time |3.EE? | (b=} (Actual value: 3.675)
- AND16 conversion time setting

Input sampling time |3.EE? | (b=} (Actual value: 3.675
— Conversion time setting

Total conversion time (Group A) 4725 (=)

Total conversion time (Group B) | | (s

Total conversion time (Group C) | | (s

ADSTO pin output enable (P8 ~|
— Interrupt setting

Enable AD conversion end intermupt (S12AD1)

Priority Level 15 (highest) -

[¥] Enable AD conversion end intemupt for group B (GBADI)

Priority

[ Level 15 (highest)

- |

[¥] Enable AD conversion end intemupt for group C (GCADI)

Priority

[ Level 15 (highest)

- |

Figure 4-8 A/D Converter tab-2
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RSKRX24T 4. Code Generation Using the CS+ plug in

4.4.5 Serial Communications Interface

Navigate to the ‘Serial Communications Interface’ tab in Code Generator, select the SCI5 sub-tab and apply
the settings shown in Figure 4-9. In the RSKRX24T SCI5 is used as an SPI master for the Pmod LCD on the
PMODL1 connector as shown in the schematic.

i Property|ffﬂ Peripheral Functions™

%] GenerateCode | & [ o B o R = ) (0 D D P T o P I G bk w3
scit | SCI5 | sci |

. General setting | Setting |
- Function setting
) Unused
(7) Asynchronous mode Transmission
(7 Asynchronous mode (Multi-processor) Transmission
(7} Clock synchronous mode Transmission
(7) Smart card interface mode Transmission
() Simple IIC bus
@ Simple SF1bus Master transmit only -
—Pin setting
TXD5 PES RXD5 PEG
SSDAS FBES S5CL5 FEE
SMOSI5 FES - SMISO5 FBE

Figure 4-9 SCI5 General Setting tab

Select the SCI5 ‘Setting’ sub-tab and configure the SPI Master as illustrated in Figure 4-10. Make sure the
‘Transfer direction setting’ is set to ‘MSB-first’ and the ‘Bit rate’ is set to 10000000. All other settings remain at
their defaults.

5 Prnperty|2ﬂ Peripheral Functions™ |
—

78] GenerateCode | & [ & 3 E ot ) 0 & G s 23
& S D EE WS B F o F I Gi 4 2
sci1 | Scis | scis |

General setting | Seﬂ_mu_|

— Transfer direction setting
() LSBHirst @ MSBirst

- Data inversion setting
@ Nomal ) Inverted

- Transfer rate setting
Transfer clock Internal clock - FE7 -

Bit rate 10000000 - bps)  (Actual value: 10000000, Emor : 0%)

[] Enable modulation duty comection

SCKS pin function Clock output -
~Clock setting
Clock delay Clock is not delayed -

[] Enable clock polarity inversion

- Data handling setting

Transmit data handling Diata handled in interrupt service routine -
~ Interrupt setting
TXI5, TEI5 priority Level 15 (highest) -

- Callback function setting
Transmission end

Figure 4-10 SCI5 SPI Master Setting
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RSKRX24T 4. Code Generation Using the CS+ plug in

Staying in the ‘Serial Communications Interface’ tab in Code Generator, select the SCI1 sub-tab and apply the
settings shown in Figure 4-11. In the RSKRX24T SCI1 is connected via a Renesas RL78/G1C to provide a
USB virtual COM port as shown in the schematic.

Property j} Peripheral Functions™
=
f5] GenerateCode | % (O &5 = @ ¥ B2 20 @ 0 D D L 7 8 7 I & b=
SCi | scis | scie |
Generalseﬂing§| Setting ‘
Function setting

) Unused

@ Asynchronous mods Transmission/reception -
() Asynchronous mode (Multi-processor) Transmission

() Clock synchronous mods Transmission

~) Smart card interface mode

") Simple IIC bus
") Simple SPIbus Slave transmitreceive
Pin setting
TXDA PD3 - RXD1 FD5 -
PD3 PD5
PD3 FD5

Figure 4-11 SCI1 General Setting tab

Select the SCI1 ‘Setting’ sub-tab and configure SCI1 as illustrated in Figure 4-12. Make sure the ‘Start bit
edge detection’ is set as ‘Falling edge on RXD1 pin’ and the ‘Bit rate’ is set to 19200 bps. All other settings
remain at their defaults.

—

fo] GenerateCode | % 0 8 [ & M 538 B 0 O O & 7 o 7 & S ¥ M2
scit | scis [ scie |
General setting | Se’ﬂ4WI|

Start bit edge detection setting
) Low level on RXD1 pin @ Falling edge on RXD1 pin

Data length setting

) 9bits @ 8bits () 7hbits
Parity setting
@ None ) Even © Odd

Stop bit length setting

@ 1bit © 2bis
Transfer direction setting

@ LSBHirst ©) MSBHirst

Transfer rate setting

Transfer clock Internal clock -
16 cycles for 1-bit period
Bit rate 15200 - bps) (Actual value: 19230.769, Emor: 0.16%)
[] Enable modulation duty comection
SCK1 pin function SCK1 is not used - PD4
Moise filter setting
[] Enable noise fiter

Clock signal divided by 1

Hardware flow control setting
@ None ® cTs ) RTS
PD&
Data handling setting
Transmit data handling Data handled in interrupt service routine -
Receive data handling Data handled in interrupt service routine -
Interrupt setting
Enable emor intemupt (ERI1)
TXI1, RXI1, TEI, ERI priority Level 15 (highest) -
Callback function setting

Transmission end Reception end Reception emor

Figure 4-12 SCI1 Asynchronous Setting
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4. Code Generation Using the CS+ plug in

4.4.6 I/O Ports

Referring to the RSK schematic, LEDO is connected to PB3, LED1 is connected to PE5, LED2 is connected to
P53 and LED3 is connected to P52. Navigate to the ‘I/O Ports’ tab in Code Generator and configure these
four 1/O lines as shown in Figure 4-13, Figure 4-14 and Figure 4-15 below. Ensure that the ‘Output 1’ tick
box is checked. This ensures that the code is generated to set LEDs initially off.

Figure 4-13 1/O ports — PortB

@Ganerale(:ude i’*-‘E'&"Eﬁ’*%iﬁ@Q@%é’fﬁﬁj‘l{’lihd“\:{gn'@
| Porto [ Portl [ Port2 | Port3 | Ports | Pert5 | Port | Port7 | Porta | Ports [ Porta | PortD [ PortE |
- PBO

@ Unused @ In © Out P CMOS output Ou Hig ve
- PE1

@ Unused @ In ) Out P CMOS output Ou High-drive
-PB2

@ Unused @ In ) Out P CMOS cutput Oy High-drive
-PB3

() Unused @ In @ Out P CMOS cutput - Output 1 [T] High-drive output
PB4

@ Unused & In ) Out P CMOS output 4] Hig ve
- PBS

@ Unused @ In L D Oout ¥ P CMOS output Ou High-drive
- PBE

@ Unused @ In ) Out P CMOS output Ou Hig =
_PE7

@ Unused ©int @ Oou ¥ P CMOS cutput Ou High-drive

Preperty | 5 Periphersl Functions® |
T GenerateCode | % [ @ 1= # M A ) G O D & T o 7 QoM B

[ Porto | Portt | Port2 | Pora | Ports | Port5 | Ports | Port7 | Porta [ Ports | Porta | Porte [ Portd | PortE |

© Uused O © Out P CMOS otput Output High-drive
-PE1

© Uuzed O n © Out P CMOS otput Output High-drive
-PE2

@ Unused @ n
-PE3

@ Unused @ In ) Out P CMOS output Output High-drive
-PE4

@ Unused @ In () Out P CMOS output Output High-drive
-PE5

0 Unused @ @ Out P CMOS output v Output 1 [C] High-drive output

Figure 4-14 1/O ports — PortE

':E.]Generate{:crde _-,i_- [m| ﬁﬁ'ﬁl#%;‘{i@@_@%&ufﬁufﬁn L’;“m'ﬂ!‘-\l{ﬂﬂ:@-
| Portd | Portt | Port2 | Port3 | Port4 | PortS | Portf | Port7 | Portg | Portd | Port | PortB | PoriD | PoriE |

@ Unused ©hn @) Out Pull-up Output
- P51

@ Unused ©n @ Out Pull-up Output
P52

) Unused ©h @ Out Pull-up Output 1
- P53

™) Unused @ In @ Out Pull-up Output 1
P54

@ Unused O n ) Out Pull-up Outp
- PB5

@ Unused O n ) Out Pull-up Outp

Figure 4-15 1/O ports — Port7
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4. Code Generation Using the CS+ plug in

P55 is used as one of

the LCD control lines, together with PB4, PD0O and PD1. Configure these lines as shown

in Figure 4-16, Figure 4-17 and Figure 4-18.

‘GJ Generate Code

A Sl - - s I T T~ s el

| Portd | Pertt | Port2 | Port3 | Portd | Ports | Port6 | Port7 | Ports | Port9 | Porta | PortB | PortD | PortE |

'@j Generate Code

- PBD

@ Unused @ In © Out Pull-up CMOS output Output 1 High-drive output
- PB1

@ Unused @ In ) Out Pull-up CMOS output Cutput 1 High-drive output
-PB2

@ Unused @& In @ Out Pull-up CMOS output Cutput 1 High-drive output
- PB3

) Unused @ In @ Out Pull-up CMOS output - Output 1 [T] High-drive output
- PB4

) Unused (S @ Out Pull-up CMOS output - Output 1 [ High-drive output

Figure 4-16 1/O ports — PortB

- < N 5 T T -l N I L =

| Portd | Port | Port2 | Port3 | Pert4 | Port5 | Ports | Port7 | Portg | Port® | Porta. | Portg | FortD | portE |

- PDD

) Unused
- PD1

O n @ Out Pull-up CMOS output - [ output 1 [] High-drive output

) Unused

© In @ Out Pull-up CMOS output - Output 1 [T] High-drive output

Figure 4-17 1/O ports — PortD

] GuenteCose | X O S # M EBDODD BT BTE LS M

| Portd | Port1 | Port2 | Port3 | Port4 | PortS | Porté | Port7 | Port8 | Portd | Porta | PortB | PortD | PortE |

@ Unused i In i Out Pull-up Output 1
- P51

@ Unused @ In @ Out Pull-up Output 1
- P52

) Unused @ In @ Out Pull-up Output 1
-Ph3

™) Unused @ In @ Out Pull-up Output 1
- P54

@ Unused @ In @ Out Pull-up Output 1
P55

) Unused i In @ Out Pull-up Output 1

Figure 4-18 1/O ports — Port5
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Peripheral function configuration is now complete. Save the project using the File -> Save Project menu item,
then click ‘Generate Code’. The Output pane should report ‘The operation of generating file was successful’,
as shown Figure 4-19 below.

Output

M0403002
M0403001
M0403000
M0403000
M0403000
M0403000
M0403000
0403000
M0403000
M0403000
M0403000
M0403000
M0403000
M0403000
M0403000
0403000
M0403000
M0403000
M0403000
M0403000
M0403000
M0403000
M0403000
M0403000
M0403000
M0403000
0403000
M0403000
M0403000
M0403000
M0403000
M0403000
M0403003

:The generzsting source folder is: C:'\wc::kspace'\CC—_l’uccrial'\(J
:The following files were generated:d
eg_sre\r_cg_main.c was generated..|
zeg_srohr_cg_dbsct.c was genezated.d
ceg_srcoh\r_cg_intprg.c was generated.(J
:cg_src\r_cg_resetprg.c was generated.,|
ceg_srehr_cg_sbrk.c was generated.d
eg_sre\r_eg_vecttbl.c was generated.,|
cg_src\r_cg_sbrk.h was generated.,|
zeg_srchr_cg stacksct.h was generated.d
eg_sre\r_cg_vect.h was generated..|
zog_srohr_cg_hardware_ setup.c was genera:ed.d
zeg_sroh\r_cg_macrodriver . h was generated.d
:eg_sre\r_cg_userdefine.h was generated.
teg_sro\r_cg_cge.c was generated.]
eg_sre\r_eg_cge_user.c was generated.,|
cg_src\r_cg_cge.h was generated.|
teg_srchr_cg icu.c was generated.d
eg_sre\r_cg_icu user.c was generated..|
teg_srohr_cg_icu.h was general:ed.(J
teg_sro\r_cg_port.c was generated. .|
:eg_sre\r_cg_port_user.c was generated..|
teg_srohr_cg_port.h was generated.(J
zog_sroh\r_cg_cmt.c was generated.d
tcg_src\r_cg_cmt_user.c was generated.,|
teg_sreh\r_cg_cmt.h was generated.d
eg_sre\r_eg_sci.c was generated.,|
cg_src\r_cg_sci_user.c was generated.,|
teg_srchr_cg sci.h was generated.d
eg_sre\r_cg_sllad.c was generated..|
zeg_srohr_cg_sliad user.c was generated.(J
zeg_srohr_cg_sliad.h was genezated.d

:The cperation of generating file was successful..|

' AllMessages /| *Code Generator ,( *Rapid Build /

Figure 4-19 Code generator console

Figure 4-20 shows the Code Generator Files in the Project Tree pane. In the next section the CG_Tutorial
project will be completed by adding user code into these files and adding new source files to the project.

Figure 4-20 Code Generator Files in the Project Tree

: @ 2@

-1 CG Tutorial (Project)
R5F524TAAXFP (Micracontroller)

i KCode Generater (Design Tool)
4, CC-RX (Build Tool)

e, RX Simulator (Debug Tool)

3 File

ﬂ Build toel generated files
-1} Code Generator

& r_cg_main.c
‘ﬂ r_cg_dbsct.c
‘ﬂ r_cg_intprg.c
‘ﬂ r_cg_resetprg.c
& r_cg_shrk.c
‘ﬂ r_cg_vecttbl.c
U 1r_cg_hardware_setup.c
& r_cg_cgec
& r_cg_cgc_user.c
‘ﬂ r_cg_icu.c
‘ﬂ I_cg_icu_user.c
& r_cg_port.c
‘ﬂ 1_cg_port_user.c
‘ﬂ r_cg_cmt.c
& r_cg_emt_user.c
!ﬂ r_cg_sci.c
‘ﬂ T_Cg_sci_user.c
‘ﬂ r_cg_sl2ad.c
& r_cg_s12ad_user.c
4] r_cg_sbrkh
U r_cg_stacksct.h
U r_cg_vect.h
U r_cg_macrodriver.h
U r_cg_userdefine.h
U r_cg_cgch
M| r_eg icuh
4] r_cg_porth
U r_cg_cmt.h
U r_cg_scih
M| 1_cg_slzad.h
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5. Completing the Tutorial Project

5.1

Project Settings

A, CC-RX Propenty

e In the 'Project Tree’ pane, select | > -~
‘CC-RX (Build Tool). The build IR DefautBuid
. . . . 4
properties will appear in the main Instction set archilectuas b2 architecturelisamn2)
. Uzes floating-paint. operation instructions Yes|-fpu)
win d ow. Endian typegfnpr data ’ L\llle—:ndian datal-endian=little)
. . Rounding method for floating-point constant operations round to nearest-round=nearest)
] CS+ creates a Slngle bulld Handling of denomalized numbers in foating-point constants Handles as zeros|-denormalize=off]
. . ‘ o Precision of the double type and long double type Handles in single precision|-dbl_size=4]
configuration called ‘Default Build Replaces the i pa vt sho ype. .
for the project. This has standard St haetpe e r ot i)
imi I Selects the enumeration type size automatical Mo
COde Optl m |Sat|0n turned on by Order of bit-field members P ' Allocates from right{-bit_order=right)
default_ Assumes the boundary alignment value for structure members is 1 Nol-unpack)
Enables C++ exceptional handling function [try, catch and throw)] Mol-nioexception)
Enables the Cr+ exceptional handing function [denamic_cast and tupeid] Nol-tti=aff)
General registers used only in Fast interupt functions None{-fint_register=0]
Branch width size Compiles within 24 bits(-branch=24)
Base reqgister for ROM None
Base reqgister for Ral None
Address value of base register that sets the address value 00000000
Register of baze register that sets the address value None
Build mode
Selects the build mode name to be uzed during build,
e Select the ‘Compile Options’ tab at | 4 Seurce i
. Language of the C & C99[-lang=c99]
the bottom of the propertles Language of the C++ source file C[C89)[{ang=c]
window pane. Under ‘Language of > gddition.a' ilncc:ude Dhaths
-1y . = Sustemn include paths TETENTT T ICIIOE [ TEO]
the C source flle SeIeCt ng(' = Include files at the head of compiling units Include files at the head of con
|ang:cgg)' as shown Opposite_ > Macro definition Macro defirition[0]
Irwealidates the oredefined macro
e Select the ‘Link Options’ tab at the | # Optimization y iy
. . Optimization type Mo optimize[-MOO0Ptimize)
bottom of the properties window | . section
pane. Under ‘Section -> ROM to Section start address B_1.R_1.E_2R_2B.R.5U,51/04 PResetPRG/OFFFFS000,C_1.C
i ’ > The specified zection that outputz  The specified section that outputs externally defined symbolz to t+
RAM mapped section’, add the
. ! > Section alignment Section alignment[0]
three  mappings as  shown FiM to FAM mapp ROM to RAM mapped section[3] =
0pp05|te. [0 D=R
11 D_1=R_1
I21 D=k &
. These_ s_ettings are easily added Text Edit =
by clicking the button “..." and Text
pasting the following text into the -
dialog: D_1=R_1
D_2=R_2
D=R
D 1=R 1
D 2=R 2
e This ensures that the linker
assigns RAM rather than ROM
addresses to C variables.
P 3
0K || Cancsl || e
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5. Completing the Tutorial Project

e From the ‘Build menu, select
‘Build Mode Settings...”.  Click
‘Duplicate’ and in the resulting
‘Character String Input’ dialog,

enter ‘Debug’ for the name of the
duplicate build mode.

Build Mode Settings

Selected build mode:
|

Build mode list:

e

oy

==

e The new ‘Debug’ build mode will
be added to the Build mode list.
Click ‘Close’. Now, in the main
CC-RX Property window, under
the ‘Common Options’ tab, click on
the line containing ‘Build Mode’,
click the pull-down arrow and
select ‘Debug’ from the pull-down’.

e In the ‘Frequently Used Options
(for Compile)’ group, select the
‘Optimization Level’ option and
select ‘0’ from the pull-down. We
have now created a ‘Debug’ build
mode with no code optimisation
and will be using the Build mode to
create and debug the project.

Cloze ] [ Help
4 CC-FX Property E][
4 Build Mode
Build mode DefauttBuild [+]
4 Dutput File Type and Fath Default Build
Output file type Debug
Intermediate file output folder O VIO IETIETE 75
# TR Property E] E] E][
4 Build Mode
Build mode Debug
> CPU
> PICSPID
4 Dutput File Type andPath
Output file type Execute Module[Load Module File]
Intermediate file output folder #Buildt adeM ame?
4 Frequently Used Options(for Compie]
> Additional include paths Additional include paths[2]
> System include paths System include paths[0]
> Macra definition Macro definition[0]
Outputs debugging information “Y'es[-debug]
Optimization level 0[-optimize=0) El

Outputs additional information for inter-module optimization
Optimization type

Outputs a zource list file

F Iy Used Options{for A hle)

1[-optimize=1]
2[-optimize=2]
bd a=[-optimize=maz]

R20UT3439EG0100 Rev. 1.00
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5. Completing the Tutorial Project

All of the sample code projects
contained in this RSK are
configured with three Build modes;
‘DefaultBuild’, ‘Debug’ and
‘Release’. ‘Release’ is created in
the same way as above; by
duplicating ‘Default Build'.
‘Release’ build mode leaves code
optimisation turned on and
removes debug information from

“\ CC-RX Property

4 Build Mode

Build mode:

Change property value for all build modes at once
CPU

PIC/PID

4 QDutput File Type and Path

Output file type

Intermediate file output folder
Frequently Used Options(for Compile)
Additional include paths

System include paths

VWV R

&

Release

Execute Module(Load Module File)
%BuildModeName %

Additional include paths[2]
System include paths[0]

Macro definition Macro definition[0]
the output file. No(nodebug)

Optimization level

Outputs additional information for inter-module optimization
Optimization type

Outputs @ source list file

Frequently Used Options{for A T

Additional include paths

System include paths

Macro definition

e To remove debug information from
the ‘Release’ build mode, in the
‘CC-RX Property’ window, select
the ‘Common Options’ tab at the
bottom of the window pane. For
the ‘Outputs debugging
information’ option, select ‘No(-
nodebug).

e Reset the build mode back to
‘Debug’ using the ‘Build Mode’
pull-down control.

e From the menus, select ‘File ->
Save Al' to save all project
settings.

MNo{-nolistfile)

Additional include paths [0]
System include paths [0]
Macro definition [0]

v v vk

52 Additional Folders

Project Tree 3 x

e Before new source files are added
. . A ]
to the project, we will create two | 2 @ 5 @
Build CG_Tutorial

11 1 #

additional = folders in the CS+ | © “E%U

Project Tree. ] Rebuild CG_Tutorial
_& Clean CG_Tutorial
)
=

¢ In the Project Tree pane, right-click
the CG_Tutorial project and select
‘Add -> Add New Category’.

Open Folder with Explorer
Windows Explorer Menu

| Add

-

|+ﬁ Add Subproject..

{4 Set CG_Tutorial as Active Project |+E Add Mew Subproject...

Save Project and Development Tocls as Package... 1 AddFile...
% Paste Ctrl+V ] Add Mew File...
@P Rename F2 ||; Add New Category

E3j| Property

e Rename the newly-created ‘New
Category’ folder to ‘C Source Files'.
Repeat these steps to create a new
category folder for ‘Dependencies’.

=-| % CG Tutorial (Project)*

.. RSF524TALFP (Microcontroller)
_4 Code Generator (Design Tool)
4, CC-RX (Build Tool)

2, R Simulater (Debug Teol)
=13 File
E ﬂ Build tool generated files
~..h] iodefine.h

I_]_ Code Generator

L |_]_ C Source Files
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5.3 LCD Code Integration

API functions for the Okaya LCD display are provided with the RSK. Refer to the Tutorial project folder
created according to the Quick Start Guide procedure. Locate the files ascii.h, r_okaya lIcd.h, iodefine.h,
ascii.c, and r_okaya_lcd.c in this folder. Copy these files into the C:\Workspace\CG_Tutorial folder.

e Right-click on the ‘C Source Files’ B_riﬂ File _
in the Project Tree and select ‘Add ) Build tool generated files
-> Add File...". ! Code Generator

[ C Sour I .

e Browse to the files ascii.c, and L _Depem‘ Add MJ[3 ada Fie..
r_okaya_lcd.c in the Bl Open Folder with Explorer 7] Add New File...
C:\Workspace\CG_Tutorial folder Windows Explorer Menu "7l Add Mew Category
and click ‘Add’.

Remowe from Project Shift+Del

e Repeat the above steps to add
the files ascii.h , r_okaya_lcd.h to Gapy EEl
the ‘Dependencies’ folder. Paste Cerl=v

e Repeat the above steps to add Rename F2
the file iodefine.h to the ‘File’ Property
folder.

Code must be inserted in to the user code area in many files in this project, in the areas delimited by
comments as follows:

/* Start user code for _xxxxx_. Do not edit comment generated here */
/* End user code. Do not edit comment generated here */

Where _xxxx_ depends on the particular area of code, i.e. ‘function’ for insertion of user functions and
prototypes, ‘global’ for insertion of user global variable declarations, or ‘include’ for insertion of pre-processor
include directives. User code inserted inside these comment delimiters is protected from being overwritten by
Code Generator, if the user needs to subsequently change any of the Code Generator-generated code.

In the CS+ Project Tree, expand the ‘Code Generator’ folder and open the file ‘r_cg_userdefine.h’ by double-
clicking on it. Insert the following #defines in between the user code delimiter comments as shown below.
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/* Start user code for function. Do not edit comment generated here */
#define TRUE @)

#define FALSE ()

/* End user code. Do not edit comment generated here */

In the CS+ Project Tree, open the file ‘r_cg_main.c’ by double-clicking on it. Insert #include "r_okaya_lcd.h" in
between the user code delimiter comments as shown below.

/* Start user code for include. Do not edit comment generated here */
#include "r_okaya lcd.h"
/* End user code. Do not edit comment generated here */

Scroll down to the ‘main()’ function and insert the highlighted code as shown below into the beginning of the
user code area of the main() function:

void main(void)

{
R_MAIN_UserlInit(Q);
/* Start user code. Do not edit comment generated here */
/* Initialize the debug LCD */
R_LCD_InitQ);
/* Displays the application name on the debug LCD */
R_LCD_Display(0, (uint8_t *)' RSKRX24T ');
R_LCD_Display(1l, (uint8_t *)" Tutorial ");
R_LCD_Display(2, (uint8_t *)" Press Any Switch ");
while (1U)
{
/* End user code. Do not edit comment generated here */
3
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5.3.1 SPI Code

The Okaya LCD display is driven by the SPI Master that was configured using Code Generator in §84.4.5. In
the CS+ Project Tree, open the file ‘r_cg_sci.h’ by double-clicking on it. Insert the following code in the user
code area at the end of the file:

/* Start user code for function. Do not edit comment generated here */
MD_STATUS R_SCI5_SPIMasterTransmit(uint8 t * const tx_buf, const uintl6_t tx_num);
/* End user code. Do not edit comment generated here */

Now, open the r_cg_sci_user.c file and insert the following code in the user area for global:

/* Start user code for global. Do not edit comment generated here */
/* Flag used locally to detect transmission complete */

static volatile uint8_t sci5_txdone;

/* End user code. Do not edit comment generated here */

Insert the following code in the transmitend call-back function for SCI5:

void r_sci5_callback_transmitend(void)

/* Start user code. Do not edit comment generated here */
sci5_txdone = TRUE;
/* End user code. Do not edit comment generated here */

}

Now insert the following function in the user code area at the end of the file:

/

* Function Name: R_SCI5_SPIMasterTransmit

* Description : This function sends SPI5 data to slave device.
* Arguments : tx_buf -

* transfer buffer pointer

* t>x_num -

* buffer size

* Return Value : status -

*

MD_OK or MD_ARGERROR

/
MD_STATUS R_SCI5_SPIMasterTransmit (uint8_t * const tx_buf, const uintl6_t tx_num)

{
MD_STATUS status = MD_OK;

/* clear the flag before initiating a new transmission */
sci5_txdone = FALSE;

/* Send the data using the APl */
status = R_SCI5_SPI1_Master_Send(tx_buf, tx_num);

/* Wait for the transmit end flag */
while (FALSE == sci5_txdone)

/* Wait */
}

return (status);

* N

End of function R_SCI5 SPIMasterTransmit

/

This function uses the transmit end callback function to perform flow control on the SPI transmission to the
LCD, and is used as the main API call in the LCD code module.
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5.3.2 CMT Code

The LCD code needs to insert delays to meet the timing requirements of the display module. This is achieved
using the dedicated timer which was configured using Code Generator in 84.4.3. Open the file r_cg_cmth
and insert the following code in the user area for function at the end of the file:

/* Start user code for function. Do not edit comment generated here */
void R_CMT_MsDelay(const uintl6_t millisec);
/* End user code. Do not edit comment generated here */

Open the file r_cg_cmt_user.c and insert the following code in the user area for global at the beginning of the
file:

/* Start user code for global. Do not edit comment generated here */
static volatile uint8_t one_ms_delay complete = FALSE;
/* End user code. Do not edit comment generated here */

Scroll down to the r_cmt_cmiO_interrupt() function and insert the following line in the user code area:

static void r_cmt_cmiO_interrupt(void)

{
/* Start user code. Do not edit comment generated here */
one_ms_delay_complete = TRUE;
/* End user code. Do not edit comment generated here */
3

Then insert the following function in the user code area at the end of the file:

Function Name: R_CMT_MsDelay

Description : Uses CMTO to wait for a specified number of milliseconds
Arguments : uintlé_t millisecs, number of milliseconds to wait
Return Value : None

X X ok T~

void R_CMT_MsDelay (const uintl6_t millisec)
uintl6é_t ms_count = O;

do
{
R_CMTO_Start();
while (FALSE == one_ms_delay_complete)

{
/* Wait */

(o)

R_CMTO_Stop();
one_ms_delay complete = FALSE;
ms_count++;

3} while (ms_count < millisec);

3
/

End of function R_CMT_MsDelay

/

Select ‘Build Project’ from the ‘Build’ menu, or press F7. CS+ will build the project with no errors.

The project may now be run using the debugger as described in 86. The program will display ‘RSKRX24T
Tutorial Press Any Switch’ on 3 lines in the LCD display.
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5.4 Switch Code Integration

API functions for user switch control are provided with the RSK. Refer to the Tutorial project folder created
according to the Quick Start Guide procedure. Locate the files rskrx24tdef.h, r_rsk _switch.h and
r_rsk_switch.c in this folder. Copy these files into the C:\Workspace\CG_Tutorial folder. Import these three
files into the project in the same way as the LCD files.

The switch code uses interrupt code in the files r_cg_icu.h, r_cg_icu.c and r_cg_icu_user.c and timer code in
the files r_cg_cmt.h, r_cg_cmt.c and r_cg_cmt_user.c, as described in §4.4.2 and 84.4.3. It is necessary to
provide additional user code in these files to implement the switch press/release detection and de-bouncing
required by the API functions in r_rsk_switch.c.

54.1 Interrupt Code

In the CS+ Project Tree, expand the ‘Code Generator’ folder and open the file ‘r_cg_icu.h’ by double-clicking
on it. Insert the following code in the user code area at the end of the file:

/* Start user code for function. Do not edit comment generated here */

/* Function prototypes for detecting and setting the edge trigger of ICU_IRQ */
uint8_t R_ICU_IRQIsFallingEdge(const uint8_t irg_no);

void R_ICU_IRQSetFallingEdge(const uint8_t irg_no, const uint8_t set_f_edge);
void R_ICU_IRQSetRisingEdge(const uint8_t irg_no, const uint8_t set_r_edge);

/* End user code. Do not edit comment generated here */
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Now, open the r_cg_icu.c file and insert the following code in the user code area at the end of the file:

Function Name: R_ICU_IRQIsFallingEdge

Description : This function returns 1 if the specified ICU_IRQ is set to
falling edge triggered, otherwise O.

Arguments  uint8_t irg_no

Return Value : 1 if falling edge triggered, O if not

o oX X XN

uint8_t R_ICU_IRQIsFallingEdge (const uint8_t irg_no)
{
uint8_t falling_edge_trig = 0xO0;
iT (ICU.IRQCR[irg_no]-BYTE & _04 I1CU_IRQ_EDGE_FALLING)

falling_edge_trig = 1;
3

return (falling_edge_trig);

N

End of function R_ICU_IRQIsFallingEdge

Function Name: R_ICU_IRQSetFallingEdge

Description : This function sets/clears the falling edge trigger for the
specified ICU_IRQ.

Arguments : uint8_t irg_no
uint8_t set_f edge, 1 if setting falling edge triggered, O if
clearing

Return Value : None

*ox % ok o XN

/
void R_ICU_IRQSetFallingEdge (const uint8_t irg_no, const uint8_ t set f_edge)

ifT (1 == set_T _edge)
ICU. IRQCR[irg_no].BYTE |= _04 ICU_IRQ_EDGE_FALLING;
}

else

ICU. IRQCR[irg_no].BYTE &= (uint8_t) ~ 04 ICU_IRQ EDGE_FALLING;
}

}
/
* End of function R_ICU_IRQSetFallingEdge

Function Name: R_ICU_IRQSetRisingEdge

Description : This function sets/clear the rising edge trigger for the
specified ICU_IRQ.

Arguments  uint8_t irg_no
uint8_t set_r_edge, 1 if setting rising edge triggered, O if
clearing

Return Value : None

ook X X % X F N\

void R_ICU_IRQSetRisingEdge (const uint8_t irg_no, const uint8_t set_r_edge)
if (1 == set_r_edge)
ICU. IRQCR[irg_no].BYTE |= _08_ICU_IRQ EDGE RISING;
}

else

ICU. IRQCR[irg_no].BYTE &= (uint8_t) ~_08_ICU_IRQ_EDGE_RISING;

* NS

End of function R_ICU_IRQSetRisingEdge
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Open the r_cg_icu_user.c file and insert the following code in the user code area for include near the top of
the file:

/* Defines switch callback functions required by interrupt handlers */
#include "r_rsk_switch.h"

In the same file insert the following code in the user code area inside the function r_icu_irq0_interrupt ():

/* Switch 1 callback handler */
R_SWITCH_IsrCallbackl1();

In the same file insert the following code in the user code area inside the function r_icu_irg5_interrupt ():

/* Switch 2 callback handler */
R_SWITCH_IsrCallback2();

5.4.2 De-bounce Timer Code

Open the r_cg_cmt_user.c file and insert the following code in the user code area for include near the top of
the file:

/* Defines switch callback functions required by interrupt handlers */
#include "r_rsk_switch.h"

In the same file insert the following code in the user code area inside the function r_cmt_cmil_interrupt ():

/* Stop this timer - we start it again in the de-bounce routines */
R_CMT1_Stop(Q);

/* Call the de-bounce call back routine */
R_SWITCH_DebouncelsrCallback();

In the same file insert the following code in the user code area inside the function r_cmt_cmi2_interrupt ():

/* Stop this timer - we start it again in the de-bounce routines */
R_CMT2_Stop();

/* Call the de-bounce call back routine */
R_SWITCH_DebouncelsrCal lback();

5.4.3 Main Switch and ADC Code

In this part of the tutorial we add the code to act on the switch presses to activate A/D conversions and display
the result on the LCD. In 84.4.4, we configured the ADC to be triggered from the ADTRGO# pin, SW3. In this
code, we also perform software triggered A/D conversion from the user switches SW1 and SW2, by
reconfiguring the ADC trigger source on-the-fly once an SW1 or SW2 press is detected.

In the CS+ Project Tree, expand the ‘Code Generator’ folder and open the file ‘r_cg_userdefine.h’ by double-
clicking on it. Insert the following code the user code area, resulting in the code shown below

/* Start user code for function. Do not edit comment generated here */
#define TRUE (¢D)
#define FALSE )

extern volatile uint8_t g_adc_trigger;
/* End user code. Do not edit comment generated here */
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Open the file ‘'r_cg_main.c’ and insert #include "r_rsk_switch.h" in the user code area for include, resulting in
the code shown below:

/* Start user code for include. Do not edit comment generated here */
#include "r_okaya_lcd.h"

#include "r_rsk_switch.h"

/* End user code. Do not edit comment generated here */

Next add the switch module initialization function call highlighted in the user code area inside the main()
function, resulting in the code shown below:

void main(void)

R_MAIN_UseriInit(Q);
/* Start user code. Do not edit comment generated here */

/* Initialize the switch module */
R_SWITCH_InitQ);

/* Initialize the debug LCD */
R_LCD_InitQ);

/* Displays the application name on the debug LCD */
R_LCD_Display(0, (uint8_t *)" RSKRX24T ');

R_LCD Display(1, (uint8_t *)'" Tutorial ");
R_LCD_Display(2, (uint8_t *)" Press Any Switch ");
while (1U)

/* End user code. Do not edit comment generated here */

¥
In the same file, insert the declarations in the user code area for global, resulting in the code shown below:

/* Start user code for global. Do not edit comment generated here */

/* Prototype declaration for cb_switch _press */
static void cb_switch_press (void);

/* Prototype declaration for get _adc */
static uintl6_t get_adc(void);

/* Prototype declaration for lcd_display_adc */
static void lcd_display adc (const uintl6_t adc_result);

/* Variable for flagging user requested ADC conversion */
volatile uint8_t g_adc_trigger = FALSE;

/* End user code. Do not edit comment generated here */
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Next add the highlighted code below in the user code area inside the main() function and the code inside the
while loop, resulting in the code shown below:

void main(void)

{

}

R_MAIN_UserlInit(Q);
/* Start user code. Do not edit comment generated here */

/* Initialize the switch module */
R_SWITCH_Init();

/* Set the call back function when SW1 or SW2 is pressed */
R_SWITCH_SetPressCal lback(cb_switch_press);

/* Initialize the debug LCD */
R_LCD_Init Q;

/* Displays the application name on the debug LCD */
R_LCD_Display(0, (uint8_t *)" RSKRX24T '");

R_LCD Display(1l, (uint8_t *)" Tutorial ");
R_LCD_Display(2, (uint8_t *)" Press Any Switch ");

/* Start the A/D converter */
R_S12AD0O_Start();

while (1U)
uintlé_t adc_result;

/* Wait for user requested A/D conversion flag to be set (SW1 or SW2) */
if (TRUE == g_adc_trigger)
{

/* Call the function to perform an A/D conversion */

adc_result = get_adc();

/* Display the result on the LCD */
Icd_display_adc(adc_result);

/* Reset the flag */
g_adc_trigger = FALSE;

by

/* SW3 is directly wired into the ADTRGOn pin so will
cause the interrupt to fire */

else if (TRUE == g_adc_complete)

{
/* Get the result of the A/D conversion */
R_S12AD0O_Get_ValueResult(ADCHANNELO, &adc_result);
/* Display the result on the LCD */
Icd_display_adc(adc_result);
/* Reset the flag */
g_adc_complete = FALSE;

by

else
/* do nothing */

by

/* End user code. Do not edit comment generated here */

Then add the definition for the switch call-back, get_adc() and Icd_display_adc() functions in the user code
area for adding at the end of the file, as shown below:

/
* Function Name : cb_switch_press
* Description : Switch press callback function. Sets g_adc_trigger flag.
* Argument I none
* Return value : none
/

static void cb_switch_press (void)
{

/* Check if switch 1 or 2 was pressed */

if (g_switch_flag & (SWITCHPRESS_1 | SWITCHPRESS_2))

{
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/* set the flag indicating a user requested A/D conversion is required */
g_adc_trigger = TRUE;

/* Clear flag */
g_switch_flag = 0x0;
}

3
/

* End of function cb_switch_press

Function Name : get_adc

Description : Reads the ADC result, converts it to a string and displays
it on the LCD panel.

Argument : none

Return value : uintl6_t adc value

FooE X X XN

static uintl6_t get_adc (void)
{

/* A variable to retrieve the adc result */
uintl6_t adc_result;

/* Stop the A/D converter being triggered from the pin ADTRGOn */
R_S12AD0O_Stop();

/* Start a conversion */
R_S12ADO_SWTriggerStart();

/* Wait for the A/D conversion to complete */
while (FALSE == g_adc_complete)
{

/* Wait */
}

/* Stop conversion */
R_S12ADO_SWTriggerStop(Q);

/* Clear ADC flag */
g_adc_complete = FALSE;

R_S12AD0O_Get_ValueResult(ADCHANNELO, &adc_result);

/* Set AD conversion start trigger source back to ADTRGOn pin */
R_S12ADO_Start();

return (adc_result);

N

End of function get_adc

Function Name : lcd_display_adc

Description : Converts adc result to a string and displays
it on the LCD panel.

Argument : uintl6_t adc result

Return value : none

R X X XN

static void lcd_display_adc (const uintl6_t adc_result)

{
/* Declare a temporary variable */
uint8_t a;

/* Declare temporary character string */
char lcd_buffer[11] = " ADC: XXXH";

/* Convert ADC result into a character string, and store in the local.
Casting to ensure use of correct data type. */

a = (uint8_t)((adc_result & 0x0F00) >> 8);

Icd_buffer[6] = (char)((a < Ox0A) ? (a + 0x30) : (a + 0x37));

a = (uint8_t)((adc_result & 0x00F0) >> 4);

lcd_buffer[7] = (char)((a < 0x0A) ? (a + 0x30) : (a + 0x37));

a = (uint8_t)(adc_result & 0x000F);
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Icd_buffer[8] = (char)((a < Ox0A) ? (a + 0x30) : (a + 0x37));

/* Display the contents of the local string lcd_buffer */
R_LCD_Display(3, (uint8_t *)lcd_buffer);

N

End of function lcd_display_adc

V4

Open the file ‘r_cg_s12ad.h’ by double-clicking on it. Insert the following code in the user code area for

function, resulting in the code shown below:

/* Start user code for function. Do not edit comment generated here */

/* Flag indicates when A/D conversion is complete */
extern volatile uint8_t g_adc_complete;

/* Functions for starting and stopping software triggered A/D conversion */
void R_S12ADO_SWTriggerStart(void);

void R_S12AD0O_SWTriggerStop(void);

/* End user code. Do not edit comment generated here */

Open the file ‘r_cg_sl12ad.c’ by double-clicking on it. Insert the following code in the user code area for

adding at the end of the file, resulting in the code shown below:

/* Start user code for adding. Do not edit comment generated here */

/
* Function Name: R_S12ADO_SWTriggerStart

* Description : This function starts the AD converter.
* Arguments : None
* Return Value : None
/
void R_S12ADO_SWTriggerStart(void)
{
IR(S12AD, S12ADI1) = 0U;
IEN(S12AD, S12ADI1) = 1U;
S12AD.ADCSR.BIT.ADST = 1U;
3
/
End of function R_S12AD0 SWTriggerStart
/
/
* Function Name: R_S12ADO_SWTriggerStop
* Description : This function stops the AD converter.
* Arguments : None

* Return Value : None

void R_S12ADO_SWTriggerStop(void)
S12AD.ADCSR.BIT.ADST = 0U;
1EN(S12AD, S12ADI1) = 0U;

IR(S12AD, S12ADI) = OU;
b4

/
End of function R_S12ADO_SWTriggerStop

/* End user code. Do not edit comment generated here */
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Open the file r_cg_sl12ad_user.c and insert the following code in the user code area for global, resulting in the
code shown below:

/* Start user code for global. Do not edit comment generated here */
/* Flag indicates when A/D conversion is complete */

volatile uint8_t g_adc_complete;

/* End user code. Do not edit comment generated here */

Insert the following code in the user code area of the r_s12adO_interrupt () function, resulting in the code
shown below:

static void r_sl12ad0_interrupt(void)

/* Start user code. Do not edit comment generated here */
g_adc_complete = TRUE;
/* End user code. Do not edit comment generated here */

}

Select ‘Build Project’ from the ‘Build’ menu, or press F7. CS+ will build the project with no errors.

The project may now be run using the debugger as described in 86. When any switch is pressed, the
program will perform an A/D conversion of the voltage level on the ADPOT line and display the result on the
LCD panel. Return to this point in the CG_Tutorial to add the UART user code.
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5.5 Debug Code Integration

API functions for trace debugging via the RSK serial port are provided with the RSK. Refer to the Tutorial
project folder created according to the Quick Start Guide procedure. Locate the files r_rsk_debug.h and
r_rsk_debug.c in this folder. Copy these files into the C:\Workspace\CG_Tutorial folder. Import these two files
into the project in the same way as the LCD files.

In the r_rsk_debug.h file, ensure the following macro definition is included:

/* Macro for definition of serial debug transmit function - user edits this */
#define SERIAL_DEBUG_WRITE (R_SCI1_AsyncTransmit)

This macro is referenced in the r_rsk_debug.c file and allows easy re-direction of debug output if a different
debug interface is used.

5.6 UART Code Integration

5.6.1 SCI Code

In the CS+ Project Tree, expand the ‘Code Generator’ folder and open the file ‘r_cg_sci.h’ by double-clicking
on it. Insert the following code in the user code area at the end of the file:

/* Start user code for function. Do not edit comment generated here */

/* Exported functions used to transmit a number of bytes and wait for completion */

MD_STATUS R_SCI5_SPIMasterTransmit(uint8_t * const tx_buf, const uintl6_t tx_num);

MD_STATUS R_SCI1_AsyncTransmit(uint8_t * const tx_buf, const uintl6_t tx_num);

/* Character is used to receive key presses from PC terminal */
extern uint8_t g_rx_char;

/* Flag used to control transmission to PC terminal */
extern volatile uint8_t g_tx flag;

/* End user code. Do not edit comment generated here */

Open the file ‘r_cg_sci_user.c. Insert the following code in the user area for global near the beginning of the
file:

/* Start user code for global. Do not edit comment generated here */

/* Global used to receive a character from the PC terminal */
uint8_t g_rx_char;

/* Flag used to control transmission to PC terminal */
volatile uint8_t g_tx_flag = FALSE;

/* Flag used locally to detect transmission complete */
static volatile uint8_t sci5_txdone;
static volatile uint8_t scil_txdone;

/* End user code. Do not edit comment generated here */

In the same file, insert the following code in the user code area inside the r_scil_callback transmitend()
function:

void r_scil_callback_transmitend(void)

/* Start user code. Do not edit comment generated here */
scil_txdone = TRUE;

/* End user code. Do not edit comment generated here */

}

R20UT3439EG0100 Rev. 1.00 RENESAS Page 38 of 50
Dec 29, 2015



RSKRX24T 5. Completing the Tutorial Project

In the same file, insert the following code in the user code area inside the r_scil_callback_receiveend()

function:

void r_scil_callback_receiveend(void)

{

/* Start user code. Do not edit comment generated here */
/* Check the contents of g_rx _char */
iIf (("c” == g_rx_char) || (°C" == g_rx_char))

g_adc_trigger = TRUE;
by

/* Set up SCI1 receive buffer and callback function again */
R_SCI11_Serial_Receive((uint8_t *)&g_rx_char, 1);

/* End user code. Do not edit comment generated here */

}

At the end of the file, in the user code area for adding, add the following function definition:

Function Name: R_SCI1_AsyncTransmit
Description : This function sends SCI1 data and waits for the transmit end flag.
Arguments - tx_buf -

transfer buffer pointer

t>x_num -

buffer size
Return Value : status -

MD_OK or MD_ARGERROR

ok X X X X Ok XN\

/
MD_STATUS R_SCI1_AsyncTransmit (uint8_t * const tx_buf, const uintl6_t tx_num)

{
MD_STATUS status = MD_OK;

/* clear the flag before initiating a new transmission */
scil_txdone = FALSE;

/* Send the data using the APlI */
status = R_SCI1_Serial_Send(tx_buf, tx_num);

/* Wait for the transmit end flag */
while (FALSE == scil_txdone)

/* Wait */

return (status);

}

/
* End of function R_SCI1_AsyncTransmit
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5.6.2 Main UART code

Open the file ‘r_cg_main.c’. Add the following declaration to the user code area for include near the top of the
file:

#include "r_rsk_debug.h"
Add the following declaration to the user code area for global near the top of the file:

/* Prototype declaration for uart_display_adc */
static void uart_display adc(const uint8_t adc_count, const uintl6_t adc_result);

/* Variable to store the A/D conversion count for user display */
static uint8_t adc_count = 0;

Add the following highlighted code to the user code area in the main function:

void main(void)

{
R_MAIN_UseriInit(Q);
/* Start user code. Do not edit comment generated here */
/* Initialize the switch module */
R_SWITCH_InitQ);
/* Set the call back function when SW1 or SW2 is pressed */
R_SWITCH_SetPressCal lback(cb_switch_press);
/* Initialize the debug LCD */
R_LCD_Init Q;
/* Displays the application name on the debug LCD */
R_LCD Display(0, (uint8_t *)" RSKRX24T ');
R_LCD Display(1, (uint8_t *)" Tutorial ");
R_LCD Display(2, (uint8_t *)" Press Any Switch ");
/* Start the A/D converter */
R_S12ADO_Start();
/* Set up SCI1 receive buffer and callback function */
R_SC11_Serial_Receive((uint8_t *)&g_rx_char, 1);
/* Enable SCI1 operations */
R_SCI1_Start();
while (1U)
{
uintl6é_t adc_result;
/* Wait for user requested A/D conversion flag to be set */
if (TRUE == g_adc_trigger)
{
/* Call the function to perform an A/D conversion */
adc_result = get_adc();
/* Display the result on the LCD */
Icd_display_adc(adc_result);
/* Increment the adc_count */
if (16 == (++adc_count))
{
adc_count = 0;
}
/* Send the result to the UART */
uart_display_adc(adc_count, adc_result);
/* Reset the flag */
g_adc_trigger = FALSE;
3
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/*

SW3 is directly wired into the ADTRGOn pin so will
cause the interrupt to fire */

else if (TRUE == g_adc_complete)

{

}

/* Get the result of the A/D conversion */

R_S12ADO_Get_ValueResul t(ADCHANNELO, &adc_result);

/* Display the result on the LCD */
Icd_display_adc(adc_result);

/* Increment the adc_count */
if (16 == (++adc_count))

adc_count = 0;

3

/* Send the result to the UART */
uart_display_adc(adc_count, adc_result);

/* Reset the flag */
g_adc_complete = FALSE;

else

}

h
/* End
H

/* do nothing */

user code. Do not edit comment generated here */

Then, add the following function definition in the user code area at the end of the file:

Argument

o oX X XN

Description

Function Name : uart_display_adc
: Converts adc result to a string and sends it to the UARTL.

: uint8_t : adc_count
uintl6é_t: adc result

Return value : none

static void uart_display_adc (const uint8_t adc_count, const uintl6_t adc_result)

{

}

/* Declare a temporary variable */
char a;

/* Declare temporary character string */

static char uart_buffer[] = "ADC xH Value: xxxH\r\n";

/* Convert ADC result into a character string, and store in the

Casting to ensure use of correct data type. */
a = (char)(adc_count & 0x000F);
uart_buffer[4] = (char)((a < 0x0A) ? (a + 0x30) :
a = (char)((adc_result & 0OxOF00) >> 8);
uart_buffer[14] = (char)((a < 0x0A) ? (a + 0x30)
a = (char)((adc_result & 0x00F0) >> 4);
uart_buffer[15] = (char)((a < 0x0A) ? (a + 0x30)
a = (char)(adc_result & 0x000F);

uart_buffer[16] = (char)((a < 0x0A) ? (a + 0x30) :

/* Send the string to the UART */
R_DEBUG_Print(uart_buffer);

(a + 0x37));
: (a + 0x37));
s (a + 0x37));

(a + 0x37));

local.

/

/

* End of function uart_display_adc

/

Select ‘Build Project’ from the ‘Build’ menu, or press F7. CS+ will build the project with no errors.
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The project may now be run using the debugger as described in 86. Connect the RSK G1CUSBO port to a
USB port on a PC. If this is the first time the RSK has been connected to the PC then a device driver will be
installed automatically. Open Device Manager, the virtual COM port will now appear under 'Port (COM & LPT)'
as 'RSK USB Serial Port (COMXx)', where x is a number.

Open a terminal program, such as HyperTerminal, on the PC with the same settings as for SCI1 (see §4.4.5).
When any switch is pressed, or when ‘c’ is sent via the COM port, the program will perform an A/D conversion
of the voltage level on the ADPOT line and display the result on the LCD panel and send the result to the PC
terminal program via the SCI1. Return to this point in the CG_Tutorial to add the LED user code.

5.7 LED Code Integration

Open the file ‘r_cg_main.c’. Add the following declaration to the user code area for include near the top of the
file:

#include "'rskrx24tdef.h"

Add the following declaration to the user code area for global near the top of the file:

/* Prototype declaration for led_display_count */
static void led_display_count(const uint8_t count);

Add the following highlighted code to the user code area in the main function:

void main(void)

{
R_MAIN_UseriInit(Q);
/* Start user code. Do not edit comment generated here */
/* Initialize the switch module */
R_SWITCH_InitQ);
/* Set the call back function when SW1 or SW2 is pressed */
R_SWITCH_SetPressCallback(cb_switch_press);
/* Initialize the debug LCD */
R_LCD_Init Q;
/* Displays the application name on the debug LCD */
R_LCD Display(0, (uint8_t *)" RSKRX24T ");
R_LCD Display(1, (uint8_t *)" Tutorial ");
R_LCD Display(2, (uint8_t *)" Press Any Switch ");
/* Start the A/D converter */
R_S12AD0O_Start();
/* Set up SCI1 receive buffer and callback function */
R_SCI11_Serial_Receive((uint8_t *)&g_rx_char, 1);
/* Enable SCI1 operations */
R_SCI1_Start();
while (1U)
{
uintlé_t adc_result;
/* Wait for user requested A/D conversion flag to be set(SW1 or Sw2) */
if (TRUE == g_adc_trigger)
/* Call the function to perform an A/D conversion */
adc_result = get_adc();
/* Display the result on the LCD */
Icd_display_adc(adc_result);
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/* Increment the adc_count and display using the LEDs */
if (16 == (++adc_count))

adc_count = 0;
led_display_count(adc_count);

/* Send the result to the UART */
uart_display_adc(adc_count, adc_result);

/* Reset the flag */
g_adc_trigger = FALSE;

by
/* SW3 is directly wired into the ADTRGOn pin so will

cause the interrupt to fire */

else if (TRUE == g_adc_complete)

{

}

/* Get the result of the A/D conversion */
R_S12AD0O_Get_ValueResult(ADCHANNELO, &adc_result);

/* Display the result on the LCD */
Icd_display_adc(adc_result);

/* Increment the adc_count and display using the LEDs */
if (16 == (++adc_count))
{

adc_count = 0;

led_display_count(adc_count);

/* Send the result to the UART */
uart_display_adc(adc_count, adc_result);

/* Reset the flag */
g_adc_complete = FALSE;

else

}

/* do nothing */

/* End user code. Do not edit comment generated here */

}

Then, add the following function definition in the user code area at the end of the file:

/
* Function Name : led_display_count
* Description : Converts count to binary and displays on 4 LEDSO-3
* Argument : uint8_t count
* Return value : none
/
static void led_display_count (const uint8_t count)
{
/* Set LEDs according to lower nibble of count parameter */
LEDO = (uint8_t)((count & 0x01) ? LED_ON : LED_OFF);
LED1 = (uint8_t)((count & 0x02) ? LED_ON : LED_OFF);
LED2 = (uint8_t)((count & 0x04) ? LED_ON : LED_OFF);
LED3 = (uint8_t)((count & 0x08) ? LED_ON : LED_OFF);
ks
/
* End of function led_display_count
/

Select ‘Build Project’ from the ‘Build’ menu, or press F7. CS+ will build the project with no errors.

The project may now be run using the debugger as described in 86. The code will perform the same but now
the LEDs will display the adc_count in binary form.
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6. Debugging the Project

e In the ‘Project Tree’ pane, right- | [FEEESlE i
click the ‘RX Simulator (Debug t @ alE
Tool)’.  Select ‘Using Debug
Tool -> RX E1(Serial)’.

=% CG Tutorial (Project)*

5:% RSF524TALxFP (Microcontroller)
_,_J Code Generator (Design Tool)
LA, CC-RY (Build Tool)

&
Bj!l File | Using Debug Tool  » || RX E1{Serial)
= £l Build toq = Property RX E20 (Serial)
w-| |l CodeG o
- [ CSourceFiles R Simulater

e Doubleclick ‘RX El(Serial) ||[& fropey|
(Debug Tool)' to display the |[%

. =% RX E1(Senal) Property
debugger  tool properties. 2 Intermal ROMRA

Under ‘Clock’, change the main Size of internal ROM[KBytes] 756
clock frequency to 20 MHz and gizs:-: EttrrFll RﬁM[KByts{;ZBt _ e
: Size of DataFlash memory[KBytes] 8
operating frequency to 80MHz. B
e Under ‘Connection with Target Main clock source EXTAL
B d, Chan e ‘Power target Main cl.ockfrequency[MHz] 200000
oard,, g g Operating frequency[MHz] 80.0000
from the emulator.(MAX 200mA) Allow changing of the clock source on writing internal flash memory No
to ‘Yes’ 4 Connection with Emulator
. . Emulator serial No.
e All other settings can remain at 4 Connection with Target Board
their defaults Power target from the emulator (MAX 200md) Yes
’ Supply voltage 3
Communications method FINE
FIME baud rate[bps] 2000000
e Connect the E1 to the PC and
the RSK El connector.
Connect the Pmod LCD to the
PMOD1 connector.
e From the ‘Debug’ menu select
‘Download’ to start the debug
session and download code to
the target.
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7. Running the Code Generator Tutorial

7.1 Running the Tutorial

Once the program has been downloaded onto the RSK device, the program can be executed.
Click the ‘Go’ button or press F5 to begin the program from the current program counter
position. It is recommended that you run through the program once first, and then continue to
the Tutorial manual to review the code.

®
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8. Additional Information

Technical Support
For details on how to use CS+, refer to the
help file by opening CS+, then selecting Help _
> Help Contents from the menu bar. 20l Window | Help

) O | S Help

@ Open Help for Start Panel F1
‘qlq One Point Advice...
[

‘ W
|

Tutorial
Leamn

@] Browse Renesas Electronics Microcontrollers Web
(i Detail Version Information..,

f3 About..

For information about the RX24T group microcontroller refer to the RX24T Group Hardware Manual.
For information about the RX assembly language, refer to the RX Family Software Manual.
Technical Contact Details

Please refer to the contact details listed in section 8 of the “Quick Start Guide”.

General information on Renesas microcontrollers can be found on the Renesas website at:
http://www.renesas.com/

Trademarks

All brand or product names used in this manual are trademarks or registered trademarks of their respective
companies or organisations.

Copyright

This document may be, wholly or partially, subject to change without notice. All rights reserved. Duplication of
this document, either in whole or part is prohibited without the written permission of Renesas Electronics
Europe Limited.

© 2015 Renesas Electronics Europe Limited. All rights reserved.
© 2015 Renesas Electronics Corporation. All rights reserved.
© 2015 Renesas System Design Co., Ltd. All rights reserved.
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